
Chapter-1 

                    Generations of Computer 

TESTING TIME 

A. 1. a 

     2. a 

     3. c 

     4. b 

     5. c 

B. 1. Vacuum Tubes 

     2. Integrated Circuits 

     3. Second 

     4. Microprocessor 

     5. Fourth 

C. 1. True 

     2. True  

     3. False 

     4. False 

      5. True  

D. 1. First Generation 

     2. Third Generation 

     3. Fourth Generation 

     4. Second Generation 



E. 1. There are five generation knowing till date. The technology used in each 

generation is: 

First Generation – Vacuum Tube 

Second Generation - Transistor 

Third Generation – Integrated Circuit 

Fourth Generation - Microprocessor 

     2. Features of first generation computer:- 

         (i) These computers use vacuum tube. 

         (ii) They were large in size. 

     3. Limitations of Third generation Computer :- 

(i) They are cheaper than the first generation computer. 

(ii) They generated less amount of heat. 

(iii) They consumed less energy and were more reliable than their 

predecessors. 

     4. They are much smaller and cheaper than the first three generation of 

computers and they have more computing power and storage capacity than 

the earlier generation computer. 

     5. These computers are based on artificial intelligence (AI), a branch of 

computer science which aims to develop machines that will be able to think 

and take decision in the same way as humans do.  

ACTIVITY TIME 

      1. Period of development - 1940-1956, Examples- ENIAC, EDVAC. 

2. Generation – Second, Technology use – Transistor. 

3. Period of development - 1964-1971, Technology use –Integrated Circuit, 

Examples- IBM 360 series, TDC -316. 



4. Generation – Fourth, Period of development – 1971 (Onward), 

Technology use –Microprocessor. 

5. Generation –Fifth, Examples – Cray CS300 Series. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter-2 

Computer Language 

TESTING TIME 

A. 1. a 

     2. a 

     3. c 

     4. b 

     5. b 

B. 1. Language  

     2. Assembler  

     3. Binary 

     4. Machine 

     5. LISP 

C. 1. False 

     2. False 

     3. False 

     4. True 

      5. True 

D. 1. A programming language is a formal language comprising a set of 

instructions that produce various kinds of output. Programming languages are 

used in computer programming to implement algorithms. 

     2. (i) High Level Languages is easier to use and understand. 



         (ii) It is Machine- independent, so programs written in a high-level 

languages on one computer can run on any other computer with few or no 

changes. 

     3. Assembly language uses alphanumeric symbols, called mnemonics. 

Mnemonics are two- or three-letter abbreviations that denote some operation. 

For examples, ADD for addition, SUB for subtraction, etc. 

     4. Compiler: It is a Translator program that converts high level language 

program code (Source Code) into machine language code (object code). 

          Interpreter: Interpreters also converts high level language (HLL) into 

machine language. It converts one line of program at a time.  

     5. Assembler is needed to translate assembly language into machine 

language. 

ACTIVITY TIME 

1. Advantages - A computer can execute machine language instructions 

directly, without any translation. 

2. Advantages - Assembly language is easier to use and understand as 

compared to machine language. 

Disadvantages - Like Machine language, assembly language is also machine – 

dependent. 

3. Advantages –High Level language is easier to use and understand. 

Disadvantages- A Language translator is needed to convert high level language 

program into machine language. 

4. Advantages –These languages are designed to reduce overall time, 

effort and cost of developing programs. 

Disadvantages- Very advanced technology was required to fabricate to the ICs. 

5. Advantages – Decisions-making machines can be developed. 

Disadvantages – Programs are more complicated as compared to the 

programs written in other languages. 



2. 

     (a). (iv) 

     (b). (v) 

     (c). (ii) 

     (d). (i) 

     (e). (iii) 

     

 

 

 

 

 

 

 

 

 

 

 

 



Chapter-3 

More on Windows 10 

TESTING TIME 

A. 1. c 

     2. b 

     3. a                                                                                                                                                                                                                                                                                                                                   

     4. a 

     5. b 

B.  1. Operating System 

     2. Windows 10 

     3. Peek 

     4. Disk Cleanup 

     5. Jump List 

C. 1. False 

     2. False 

     3. True 

     4. True 

      5. True 

D. 1. Jump List 

     2. Peak Features 

     3. Arranging Windows side by side 

     4. Taskbar Previews 

 



E. 1. Windows 10 is one of the best trending operating system that was 

released by Microsoft on July 29, 2015. It can run on desktop computers,      

2. Shake feature lets you minimise all the open windows expect the desired 

one. 

3. To use jump list features, follow these steps. 

          Step-1 Right click on the program icon on the taskbar that contains the 

file you want to open. 

           Step-2 Click on the file you want to open. 

     4. The disk cleanup utility application that removes unnecessary 

(temporary) files to three up space on the disk 

     5. When we create, delete , move and copy files in hard disk, then after 

some long time, files and folders split between the blocks far from each other. 

This results into disk fragmentation. To resolve this problem Follow these steps 

Step-1 Open control panel window 

Step-2 Select the administrative tools option from the list under and system 

and security option. 

Step-3 Double click the defragment and optimize devices tool. 

Step-4 Select the disk drive you want to defragment and click the optimize 

option. 

ACTIVITY TIME 

A. 1.           2.       3.          4.          5.        6.  

 

 

 

 



Chapter-4 

More on PowerPoint 2016 

TESTING TIME 

A. 1. a   

     2. c 

     3. c                                                                                                                                                                                                                                                                                                                                   

     4. b 

     5. a 

B.  1. Star 

     2.  Animation 

     3.  Four 

     4. Insert  

     5. Transitions 

C. 1. False 

     2. True 

     3. False 

     4. True  

      5. True 

D. 1. Four categories of animation effects are :- Entrance, Emphasis, Exit & 

Motion paths. 

     2. Animations – Animations refers to special visual or sound effects that can 

be added to the text, picture, table, SmartArt graphic or any other object on 

the slide. 



Transition – Slide transitions are the motion effects that occur when you move  

(transit) from one slide to the next during the slide show. 

     3. To remove all the animation effects simultaneously, select the object and 

click none at the top of the gallery of animation effects.  

     4. In Normal view, select the slide you'd like to add a video to. 

         On the Insert tab, click Video, and then click Movie from File. 

         In the Choose a Movie dialog box, select the file you want to insert. If you             
want to embed the video on the slide, simply click Insert. 

     5.The rehearse timings feature of power point that lets you record the time 

you need to present each slide, and the total time required for the whole 

presentation. 

     6. Step -1 In normal view, select the slide in which you want to insert the 

audio. 

         Step-2 Click the Insert tab and then click the audio button in the media 

group. 

         Step-3 audio on my PC select this option to insert an audio file saved on 

your computer. The insert audio dialog box appears, locate and select the 

desired audio file and click the insert button. 

ACTIVITY TIME 

A. a. (iii)      b. (iv)     c. (v)      d. (i)       e. (ii)   

B. Step-1 Normal 

     Step-2 Insert, Video, Media 

     Step-3 Online Video 

     Step- 4 You tube 

     Step-5 Insert 

 

 



Chapter-5 

More on Excel 2016 

TESTING TIME 

A. 1. c  

     2. b 

     3. b                                                                                                                                                                                                                                                                                                                                 

     4. c 

     5. a 

B. 1. Row header 

     2. First Cell 

     3. Redo 

     4. 15 

     5. Fill handle 

C. 1. False 

     2. True 

     3. True 

     4. True 

     5. False 

 D. 1. Step-1 Select the row before which you want to insert the new row. 

          Step-2 On the home tab, click the down arrow of the insert button in the 

cells group. 

          Step-3 Select the Insert Sheet Rows option from the list to insert a row or 

insert sheet columns option to insert a column. A new row is inserted and the 

selected row shifts down. 



      2. To overwrite the cell contents, click on the desired cell and start typing 

the new contents. Once the data is entered, press the enter key on the 

keyboard. 

      3. The undo button on the quick access toolbar is used to cancel the last 

action performed. While the Redo button on the quick access toolbar to repeat 

the last undone action. 

      4. Step-1 Select the cell you want to copy. 

          Step -2 On the home tab, click the copy button in the clipboard group. 

          Step -3 Click in the cell where you want the same data. 

          Step-4 On the home tab, click the Paste button in the clipboard group. 

The selected data is copied to the new location.  

      5. Delete cells, delete sheet rows, delete sheet columns, delete sheet. 

      6.  Autofill is a very useful feature provided by excel. It lets you enter a 

series of data such as days of week, month of year or number series, quickly 

without typing all the value. 

        ACTIVITY TIME 

A. a. (ii)   b. (v)  c. (i)  d. (iii)  e. (iv) 

 

 

 

 

 

 

 

 



Chapter-6 

Formulas and Functions in Excel 2016 

TESTING TIME 

A. 1. a  

     2. c 

     3. b                                                                                                                                                                                                                                                                                                                                 

     4. a 

     5. c 

B. 1. Constants 

     2. Mathematical 

     3. Functions 

     4. Arguments 

     5. Compound 

C. 1. True 

     2. False 

     3. False 

     4. True 

     5. True 

D. 1.  Function generally consists of two parts. 

       (i). Functions Name : This is the name of the function. For example, SUM, 

PRODUCT, etc. 

      (ii). Arguments : These are the values that a function takes and performs 

calculations on them.    



     2. The Now and Today functions do not take any arguments.  

     3. Compound formulas contain more than one operator. For example, to 

create a formula to calculate the loss% using the formula (C.P.-S.P)/C.P*100. 

     4. Cell reference can be of three types,  

        (i) Relative- Relative cell references are basic cell references that adjust 
and change when copied or when using AutoFill. Example: =SUM(B5:B8). 

        (ii) Absolute – The cell reference that is permanent or absolute and does 
not change on copying the formula is known as absolute cell reference. For 
example, the absolute reference of cell D2 is $D$2. 

       (iii) Mixed - A mixed reference is a reference that refers to a specific row or 
column. For example, $A1 or A$1. 

     5. Mathematical functions are used to perform calculations on numerical 
data in the cell. For example, SUM; AVERAGE;  

         Statistical functions apply a mathematical process to a group of cells in a 
worksheet. For example, the SUM function is used to add the values contained 
in a range of cells. 

ACTIVITY TIME 

1. a. Mathematical  

b. Mathematical 

c. Mathematical  

d. Date and Time 

e. Text 

        2.  Formulas in Excel, There are four basic elements of a formula in MS 

excel which are: Constants, Referenced, Operators, Parenthesis. 

              In addition to entering formulas, you can also enter many predefines 

functions available in excel. A function generally consists of two parts : 

Function name and Argument.  

         3.          a. It gives the remainder on dividing two numbers. 

b. It displays the square root of a number – the number should be 

greater than 0. 

c. It finds the maximum value in a given set of values. 

d. It finds the minimum value in a given set of values. 

e. It calculates the average of the given arguments. 



      

 

Chapter-7 

Introduction to Flash CS6 

TESTING TIME 

A. 1. a 

     2. c 

     3. b                                                                                                                                                                                                                                                                                                                                  

     4. c 

     5. a 

B.  1. Pen 

     2. Work area 

     3. Selection, Lasso 

     4. Shift 

     5. Text 

C. 1. True 

     2. True 

     3. false 

     4. True 

     5. True 

D.  1. Flash is a software platform used for creating computer animations, 

cartoons, graphics, animated logos, mobile – based applications etc.  



      2. The Stage is the area on which you position all the content of your movie. 

The work area allows you extra space for organizing graphics and images that 

you want to include in a movie but might not be ready for yet on the Stage. 

      3. The Pen tool lets you draw precise paths like straight lines and smooth 

flowing curves. 

      4. with the help of rectangle tool. 

      5. Eraser Mode modifier helps the user to select the required erasing mode. 
This icon includes five options which are as follows:  

(i) Erase Normal  (ii) Erase Fills  (iii) Erase Lines (iv) Erase selected fills (v) Erase 
inside. 

      6. The Flash timeline consists of Playhead, frames and layers. 

ACTIVITY TIME 

A. 1. See page no 71. 
B. a. (v) 

b. (iv) 
c. (i) 
d. (iii) 
e. (ii) 

 

 

 

 

 

 

 

 

 

 

 



 

 

Chapter-8 

Animations in flash 

TESTING TIME 

A. 1. c 

     2. c 

     3. c                                                                                                                                                                                                                                                                                                                                   

     4. c 

     5. c 

B.  1. Frame  

      2. Animation  

      3.  Library  

      4. Manually 

      5. Window 

C. 1. False 

     2. True 

     3. True 

     4. True 

     5. True 

D.  1. Symbols in flash:  

A symbol refers to any reusable graphic, movie clip, button or text used or 

created in flash. 



An Instant is a copy of the original symbol which we drag from the library onto 

the stage. 

2.  Select a layer in the Timeline. 

Select Window > Library. 

Drag the symbol from the library to the Stage. 

If you created an instance of a graphic symbol, to add the number 

of frames that will contain the graphic symbol, select Insert > 

Timeline > Frame. 

3. Step -1 Click the file menu, point to import and then click import to 

library option. 

Step-2 Locate the image you want to import and select it. 

Step-3 Click the open button. The selected image is imported to 

the library. 

4. In a Frame by frame animation, the change in the object has to be 
created in every frame. 
In a tweened animation, only the first and last frame of the 
animation are to be defines manually. There are two types of 
tweened animation: Motion tween and shape tween.  

5. Motion tweening works on groups and symbols, where shape 
tweening requires editable objects. 

6. In a tweened animation, each frame needs not be animated 
manually and they are faster and smaller in size than frame-by-frame 
animations. 

CTIVITY TIME 

1. a. F6. 

            b. Ctrl+L 

            c. Enter 

            d. Ctrl+Enter 

            e. Press O 

2. Step-1 Stage 

    Step-2 Selection 

    Step-3 Modify 

    Step-4 Name 

    Step-5 Type 

    Step-6 Ok 

 



 

Chapter-9 

Introduction to Small Basic 

TESTING TIME 

A. 1. a 

     2. a 

     3. a                                                                                                                                                                                                                                                                                                                                   

     4. c 

     5. c 

B.  1. 14 

     2. White 

     3. Apostrophe 

     4. Keywords 

     5. Boolean 

C. 1. True 

     2. False 

     3. True 

     4. False 

     5. True 

D. 1. Small Basic is a programming language that is designed 

to make programming extremely easy, approachable and fun for beginners.  

     2. (i) Small basic provides a user- friendly environment. 

         (ii) The Language consists of only 14 keywords. 



         (iii) It has only AND and OR logic operator. 

     3. The TextWindow provides text-related input and output functionalities. 

For example using this class, it is possible to write or read some text or number 

to and from the text-based text window. 

     4. The value which does not change during the program execution are called 

the constants. A Location in the memory which is assigned a name is called a 

variable  

     5. Small basic provides built-in Math functions which can be used to 

perform mathematical operations in your program. Some of the functions are 

listed 

 (i) Compares two numbers and returns the greater of the two. For example 

Math.Max (15, 25) =25. 

 (ii) Compares two numbers and return the smaller of the two. For example 

Math.Min(15,25) =15. 

(iii) Divides the first number by the second and returns the remainder. For 

example Math.Remainder(18,5)=3. 

     6. IntelliSense is one of intelligent code completions produced by Microsoft. 

It helps programmer to code by showing candidate keywords from typed keys. 

ACTIVITY TIME 

A. 1. See page no.98. 
2. See Page No. 105. 

 

 

 

 

 

 

 

 

 



 

Chapter-10 

Conditions and Branching In Small Basic 

TESTING TIME 

A. 1. c 

     2. a 

     3. c                                                                                                                                                                                                                                                                                                                               

B.  1. Flow 

     2. Else 

     3. False 

     4. If elseif 

     5. Branching 

C. 1. True 

     2. False 

     3. True 

     4. True 

D.  1. In Some case, we need to perform some action, even if the statement is 

false. In such cases, we use if then else statement.  

Syntax: If<condition> Then 

               <Statements_1> 

               <Statements_2> 

                 Else  

                 EndIf          



 

2. If Elself ladder is used to check multiple conditions in a program. It 

allows you to check between multiple test expressions and execute 

different statements. 

3. A label is a position for the destination from Goto statements. 

Classic BASIC language uses a line number instead of a label for Goto. 

4. It transfers the program control to any other segment of the program 

marked with some label. The Goto statement can be used independently 

or inside the If then statement. 

Example: Write a program to display first 20 natural numbers using the 

Goto statements. 

Output: Sometimes , the Goto statement can result into an infinite 

execution of the program because the program may not have any 

condition to stop the execution. 

      ACTIVITY TIME 

1. TextWindow.Title=’’Positive or Negative’’ 
Number=TextWindow.ReadNumber() 
If(number>=0) Then 
TextWindow.writeLine(‘’The Number is positive’’) 
EndIf 
TextWindow.WriteLine(‘’The Number is Negative’’) 
EndIf 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

Chapter-11 

Internet Services 

TESTING TIME 

A. 1. c 

     2. c 

     3. b                                                                                                                                                                                                                                                                                                                                  

     4. b 

     5. c 

B.  1. Four 

     2. Online 

     3. Internet 

     4. Chat room 

     5. Wide Web 

C. 1. False 

     2. True 

     3. True 

     4. True 



     5. True 

D. 1.Internet stands for interconnected Network. Is is a large networks that 

connects millions of computers around the world. 

     2. World wide web (www), simply called web, is a system of interlinked 

pages or documents that can be accessed over the internet by the people 

throughout the world. 

     3. E-learning saves time and money. With online learning, your learners can 

access content anywhere and anytime 

     4. Chat room is a place on the internet that allows multiple users to join in a 

conversation and see what all other users are typing. IM enables you to chat 

with people whom you invite. You can create a list of people you want to chat 

with. 

    5. Video conferencing is a system that allows two or more people at 

different locations to communicate via audio and video transmission. 

ACTIVITY TIME 

1. a. ARPA – Advanced Research Projects Agency. 

b. Internet – Interconnected Network 

c. VSNL –  Videsh Sanchar Nigam Limited 

d. WWW – World Wide Web 

e. ISP – Internet Service Providers 

2. a. (ii) 

b. (v) 

c. (i) 

d. (iii) 

e. (iv) 

 

 

 



Work Sheet-1 

(Chapters 1 to 5) 

1. Tick the correct option. 

a. iii 

b. ii 

c. ii 

d. ii 

e. i 

2. Fill in the blanks. 

a. Vacuum Tubes  

b. LISP 

c. Machine 

d. First 

e. Redo 

f. 15 

3. True/False. 

a. False  

b. False 

c. True 

d. False 

e. True 

4. Identify the icons and name the type of PowerPoint views. 

a. Border  



b. Clear 

c. Paint Brush 

d. Delete 

e. Select All 

f. Insert  

5. Application based questions. 

a. Second Generation 

b. Alt+Tab 

c. All programs will take equal time to execute. 

d. Record Audio 

e. Yes, Dark animation effect will be applicable. 

6. Answers the following questions. 

a. (i) High Level Languages is easier to use and understand. 

         (ii) It is Machine- independent, so programs written in a high-level 

languages on one computer can run on any other computer with few or no 

changes. 

b. Shake feature lets you minimise all the open windows expect the desired 

one. 

c. Features of first generation computer:- 

         (i) These computers use vacuum tube. 

         (ii) They were large in size. 

d. To use jump list features, follow these steps. 

          Step-1 Right click on the program icon on the taskbar that contains the 

file you want to open. 

           Step-2 Click on the file you want to open. 



e. Delete cells, delete sheet rows, delete sheet columns, delete sheet. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Work Sheet-2 

(Chapters 6 to 10) 

1. Fill in the blanks. 

a. insert 

b. Functions 

c. Apostrophe 

d. expression  

e. notification 

2. Tick the correct option. 

a. iii 

b. i 

c. iii 

d. iii 

e. iv 

3. True/False. 

a. True 

b. False 

c. True 

d. True 

e. True 

4. Given below are the name of few functions. Write the category to which 

they belong? 

a. Mathematical  



b. Mathematical 

c. Mathematical  

d. Date and Time 

e. Text 

5. Application based questions. 

a. max () and min()  

b. F5 key  

c. Selection Tool  

d. Using Shape Tween Animation .. Use page no. 91 

e. Ina tweened animation, each frame needs not be animated manually and 

they are faster & smaller in size than frame -by – frame animations. This makes 

it easier to create a tweened animation in comparison to frame – by – frame 

animation .  

6. Answers the following questions. 

a. Mathematical functions are used to perform calculations on numerical 
data in the cell. For example, SUM; AVERAGE;  

         Statistical functions apply a mathematical process to a group of cells in a 
worksheet. For example, the SUM function is used to add the values contained 
in a range of cells. 

b. Cell reference can be of three types,  
  (i) Relative- Relative cell references are basic cell references that adjust 
and change when copied or when using AutoFill. Example: =SUM(B5:B8). 
  (ii) Absolute – The cell reference that is permanent or absolute and 
does not change on copying the formula is known as absolute cell 
reference. For example, the absolute reference of cell D2 is $D$2. 

              (iii) Mixed - A mixed reference is a reference that refers to a specific 
row or column. For example, $A1 or A$1. 

c. Motion tweening works on groups and symbols, where shape 
tweening requires editable objects. 

d. In a tweened animation, each frame needs not be animated manually 
and they are faster and smaller in size than frame-by-frame animations. 



e. The TextWindow provides text-related input and output functionalities. 
For example using this class, it is possible to write or read some text or 
number to and from the text-based text window. 


